
Remote Sensing, Fall 2023 

Lab 5:  Feature Extraction 
 

Lab goals  

Satellite images like air photos can be used for manual interpretation, but because they are 

digital, we can use image processing techniques to semi-automatically extract vector features. 

The specific goal in this week's lab is to create vectors for 2-3 class features which you can 

clearly identify and reduce to a manageable number of polygons.  

There are five main steps: 

• Generate a clean layer containing the desired features –a bitmap or raster channel from 

THR or Ratio-Index-Transform or Classification 

• SIEVE to create a manageable number (but sieve works only on raster channels) 

• Generate vectors (raster to vector) –RAS2POLY or  BIT2POLY or EXPOLRAS 

• Smooth vectors – SMBOYLE or SMMCMASTER 

• Examine and clean attribute table  - calculate area stats (in Catalyst or GIS) 

Sample features to extract:  

• 1. Water   

• 2. A vegetation land cover class 

 

1. Set-up  
 

Start Catalyst and open your copy of bowron19aug2016.pix      

Change display to 654 and enhance  

 

2. Extract water from the 2016 multispectral image 

We’ll first create the water bitmap like that you created in lab2 to generate a vector shapefile for 

water: rivers and lakes.  
 

 A. Create a bitmap for water, same method as you did for PG water in lab 2 (THR).  

As water does not reflect IR, we use the NIR band to find the threshold value that separates 

water, though you will have DNs that conflict with shadows – just as in PG, .. maybe worse. 

Note that we’ll try to solve this in the DEM lab.  The maximum value for water looks to be in the 

7000 – 7100 range, but don’t take my word for it. In the THR menu, set the raster band to 5 

(NIR) and output to Viewer. Threshold Maximum is 7xxx or whatever you decide, minimum 0. 

Inevitably you will grab some shadow as well, but it’s easier to remove that later, than to go low 

and miss more water. Once you are satisfied, change output to your .pix file instead of viewer 

and run. This will create a bitmap layer in the file. You want everything in your 2016 .pix file. 



 

B. EASI modeling to improve water layer 

We can reduce the shadow problem when we consider that water is wetter than shadowed rock, 

and therefore has lower DN values in the SWIR band (6). Highlight the colour composite so that 

the DNs at bottom show RGB instead of the bitmap or another layer. 

Click in the shadows and on the water to see typical DNs in Band 6 (Red Gun). Not perfect but I 

estimate an approximate boundary at 6200 (?) between water and shadow. Try your best value. 

 

To do this, we need to: 

i. Create a new empty bitmap to take the result 

Switch from map to files tab 

Right-click on the filename  -> new -> bitmap layer   

it will give you the new bitmap number which may be 3, if your water layer was bitmap 2 

-Check to be sure by listing your bitmaps under the files tab 

 

ii. tools->  EASI modeling 

This enables a basic scripting language which will be elementary for the Python fans. 

In the pop-up box type these lines below: note that a bitmap is coded %% and a band =% 

 

if %%2=1 AND  %6 < 6200 then     (or whatever DN you found to separate water and shadow) 

%%3 =1 

Endif                 - then click on ‘Run’ 

 

This says that if for any pixel, bitmap 2 has water AND Band 6 DN is less than 6200, then that 

pixel is accepted as water in the new bitmap 3 (otherwise it’s not) –  

Note the most common errors in EASI modelling is to forget to add ‘then’ and ‘Endif’ 

 

We could have also typed: (but we already created bitmap 2) 

If %5 < 7xxx AND %6 < 6200 then … 

 

You can save your script for future use .. click on save, and name it e.g. water. It will save a file 

named water.eas in your folder. You can ‘load’ it again to re-use and not have to re-retype. 

 

But nothing has appeared on screen, so you need to add bitmap 3 to the display: 

Layer -> Add -> bitmap  (and select 3 – if that is your new bitmap number) 

You should find it has only reduced the number of shadow pixels but it will do for now. 

Basically if we want to create a perfect water layer, we might need a supervised classification. It 

could have worked much better in a non-mountain scene, e.g. lowland delta. 



3. Vectorise the bitmap to create water outlines: BIT2POLY 

 
tools-> algorithm library → BIT2POLY 
Input: the bitmap layer number (3) 
Output: viewer  
Params: smooth should be checked        RUN 
 

If you can’t see your new vector lines e.g. if they are blue, right-click on the new polygon layer 

in the display listing and change the colour 
 

Now uncheck the smooth vectors box in parameters and run again, output to the viewer, AND 
 to your 2016 pix file.  Compare the result with the smoothed version to see the effect of the 

auto- smoothing algorithm … 
Zoom in A LOT to view the difference – the ‘staircase’ of pixels has been reduced, not removed 

 
You now have two new vector layers, one smoothed (onscreen only), one saved /not smoothed. 

 

We will use a more sophisticated algorithm to smooth the unsmoothed version, written by Ray 

Boyle, U. Saskatchewan. It is called SMBOYLE and is found in the Algorithm Library. 

 

 Input your unsmoothed vector layer, output to viewer and the 2016 pix file. 
This is perhaps a better result - NOT smoothed in BIT2POLY but smoothed by SMBOYLE. The 

one smoothed only in BIT2POLY is not as rounded. 

 

Review how they compare with the 654 composite and also load the higher res. Pan layer: 

Layer-> Add -> Grayscale (and pick the Pan layer) … it may give a better idea (or Not !). 

 

Q1: Catalyst also has a BIT2LINE option – describe two linear feature types on the Bowron 

scene where you might choose to use this option to extract suitable line features  

 

 
4. Polygon attribute tables 
 

You can’t sieve a bitmap to remove wee bits, only a raster, (if we really wanted to, we could 

have generated a raster layer instead of a bitmap) … but we can remove small polygons either in 

GIS or Catalyst:  right-click on the polygon layer label and pick Attribute Manager 

The areas may be in square metres as default with UTM coordinates, and if so, we can convert to 

hectares or square kilometres to reduce ‘scientific notation’.  
 



Right-click on the Area column heading, select Table definition, change decimal places to 4 and 

display units to Kilometres.      Apply     OK 

Deselect Area heading – click on it 

 

Now we can remove small polygons the ‘GIS way’. 

Select the Record dropdown, then query by -> example 

 

Edit the statement to read:  Area < 0.01            (=1 hectare or .01 km2) 

You MUST edit using the menu provided, not your keyboard –  

Use the operator button and click on ‘entire list’ to display all values 

– if there isn't an exact 1 hectare value, click on the nearest value (e.g. just above .01) 

Click on Insert         Apply        OK 

 

Now all records are gray highlighted if Area < 0.01 km 

Right-click on one that is selected in the left column and pick delete  

You have deleted all the wee polygons smaller than 12 pixels / 1 hectare 

 

Layer-> Save as …       pick your 2016 pix file and the Polygon Layer 

 

Layer-save as again and this time scan down a few lines to the ArcGIS shapefile, and save as 

shapefile .. you could name it something like water2012.shp and save in your folder. This can be 

directly opened in ArcGIS or QGIS – unlike the layer stored in the .pix file. 
 

Click again in the top left column (blank to the left of 'ShapeID', and you should see a summary 

of stats for the water polygons, including total area (sum) for the polygons.  

 

Q2: a. how many water bodies are in this layer and what is their total area (km2) 

b. What is the area of each of the two largest lakes – (Isaac and Lanezi) (km2) ? 

 

5. Polygon layer for another land cover class - EXPOLRAS 

The EXPOLRAS algorithm tool goes beyond BIT2POLY with multiple steps to extract and 

refine features by thresholding, sieving and vectorizing in one operation. 
 
First we need a layer to work with – it might be a classification, but we’ll settle for the NDVI for 

this area, and try to extract Avalanche slopes. These are not as easy to extract as water -  
one might assume they mostly have the highest DN values in the NDVI layer.  

 



Query the DNs in this layer on the avalanche slopes – they seem to be roughly 0.7 and above, but 

the lower values overlap with the higher values on regenerating cutblocks. We may be able to 

later ‘clip out’ areas beyond the Bowron Lakes Provincial Park, which itself has no cutblocks.  

 

Load the park vector outline to see this:  

Layer-> add-> vector and browse to L:GEOG357/shapefiles/bowron-utm.shp 
[remember to do the final click on the VEC link in the bottom window] 
 

Find your best compromise NDVI minimum to capture most avalanche slopes, without an excess 

of other features - we won’t need a maximum as we assume these are the highest values. 

 
Tools → Algorithm Librarian -> EXPOLRAS 
Input: your NDVI channel 
Output: to viewer and your 2016 pix file 
Params: 
Threshold Minimum 0.xxxx  (what did you decide ?)  
Minimum Area:  12 – this is the sieve operation  

Go to log tab and Run … it should be successful 

You now have a polygon layer for avalanche slopes– you don’t need to remove small polygons 

as the minimum did this, though you may still find some small ‘donut holes’ of non-

deciduous in the avalanche slopes etc..  
 

Smoothing 1 – run SMBOYLE and output to Viewer and your .pix file 

 

Smoothing 2 – run SMMCMASTER the same way (on the vector produced by EXPLORAS), 

not already smoothed by SMBOYLE 

 

Q3a: how would you compare the two results in smoothness / realism -by viewing them against 

the composite and/or PAN layer ?  I am biased as Ray Boyle was Canadian and I met him      

b. Which one does Catalyst recommend for converted raster data and why (see ‘help’ for each. 

 
Right-click on the polygon label in the 'maps' tab and open the Attribute manager.  
convert units to square kms, and review the total. Save the polygons as a layer in the pix file and 

also save the vector segment to a shapefile (e.g. avslope.shp) 
 
You can see all cutblocks are neatly outside the Park – of course, it is a park ! 

We will clip our avalanche slopes to just get the ones inside the park -see graphic below 

 



CLIP: GRRR Catalyst has a CLIP tool, but it seems to only clip to a rectangle, so better do this 

in ArcGIS or QGIS. Note that you may first need to ‘repair geometry’ (ArcGIS) or ‘fix 

geometry’(QGIS) in the avalanche slopes shapefile, before you can clip. I’m 

assuming/hoping you all have semi-Jedi skills in one of the two GIS softwares ? 

 
Q4a: what is the area of avalanche slopes inside the park (km2) 

-accepting our image misses some parts of the park in the north 

and southeast. If you haven’t converted from metres to kms 

than just divide your answer by 100 – but you all knew there 

are 100 hectares in 1 sq. km .. 

 

4b. Having removed cutblocks outside the park, briefly 

describe any remaining ‘problematic’ features inside the park 

with high NDVI but do not seem to be avalanche slopes 

 

 

6. Edge-enhancing Filters: FED / FSOBEL  
 

The tools include a number of filters – some for smoothing, others for the opposite. They all 

sample a window of DNs e.g. 3 x 3 or 7 x 7 and perform a type of averaging or difference result.  

 

Edge filters may in some cases serve to highlight feature boundaries almost like vectors. 

Find this tool: FED 

Input channel is your NDVI, Output – viewer-grayscale (just to the screen), keep parameter 

defaults (3 x 3) and run.  

Wow!  it seems to nail the water edges, and the avalanche slopes edges are at least visible. 

 

Now try FSOBEL – same parameters and Run – maybe even better ? for the avalanche slopes ? 

 

Finally have a look at the effects of filter: FSHARP (no, it’s not music) 

As before, pick your NDVI channel for input, viewer-grayscale, params: default, run 

If you wish, increase the filter size to 11 x 11 pixels and view the result again – v. sharp ! 

Hmmm … seems we could sharpen up bands 4,5,6 and create a sharper colour composite – 

almost like pansharpening when you don’t have a separate PAN band ? 

 

Q5a: describe briefly how do the edge filters pick out water so cleanly 

5b. why does water itself have such low values in the FED and FSOBEL results ? 

 

 

 

Send answers to:  wheate@unbc.ca  by Wednesday 12 noon 
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